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Speedware is proud to have 
earned its third consecutive 
certification under the 
prestigious Support Center 
Practices (SCP) program. 

Speedware was awarded very 
high scores in a number of areas 
including customer feedback, 
Total Quality Management 
(TQM) and employee develop-
ment programs. “The 
Speedware Tech-Centre 
consistently demonstrates a 
strong level of performance 
relative to the criteria defined 
in the program,” noted Gordy 
Stauffer, Certification Auditor, 
in his assessment report. 

“Achieving strong levels of 
performance and striving to 
continuously improve our 
technical support services are 
a top priority at Speedware,” 
said Maria Anzini, Director of 
Worldwide Customer Service 
and Product Support at 
Speedware. “I am very proud 
of my technical support staff 
and appreciate the hard work 
of my colleagues in other 
departments.”
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New customers and business partners
The following press releases chronicle some of Speedware’s activities in the last few months. 

Speedware's analytics tools 

implemented in Quebec's 

public clinics (CLSCs)

Speedware is proud to announce that it will be 
providing its business intelligence (BI) solutions 
to Quebec's network of public healthcare 
clinics, known as CLSCs. The Association of 
CLSCs has developed innovative dashboards 
with Speedware's Media solution that will allow 
healthcare facilities to monitor their patient care 
performance. 

The implementation of this project will be 
completed over the next three years. To date, 
72 facilities have already signed on and it is 
expected that many others will join the program 
in upcoming months.  

Each of the participating clinics can access 
information pertaining to patient information, 
such as types and lengths of procedures, as 
well as administrative information for budgeting 
and human resource management purposes 
through a user-friendly interface in Windows 
client/server mode. 

As well, at the end of the year, a centralized 
repository of information gathered from each of 
the establishments will be available to each 
clinic through a Web-based interface. This will 
allow for easy access and exchange of 
information between clinics and will allow them 
to compare their performance indicators with 
each other.

Speedware's OLAP tools 

bundled into ERP solution 

for forestry industry

Speedware has signed a distribution 
agreement with Scoopsoft Inc., a developer of 
integrated management systems for the wood 
products industry. Speedware's advanced On-
Line Analytical Processing (OLAP) software 
tools will be integrated into Scoopsoft's ERP 
solution to allow its customers to easily analyze 
complex manufacturing data for improved 
business performance. This solution is targeted 
specifically to decision-makers in the forestry 
industry. 

This partnership will allow Scoopsoft's 
customers to analyze data, residing on their 
IBM iSeries databases, through an interactive 
interface with rich visuals, known as 
dashboards, so they can quickly identify trends 
and relationships normally hidden in data. 
Customers will be able to access pertinent 
information in a timely manner to monitor 
production, sales and financial indicators. 
Dashboards will illustrate shipment and 
production volumes against budgets, inventory 
levels, logs consumed in number and cubic 
meters, recovery and throughput rates, along 
with alerts and drill-down capabilities by mill, 
species, dimension, grade and length.

Speedware Corporation Inc.
9999 Cavendish Blvd.
St. Laurent, Quebec
Tel: (514) 747-7007
Fax: (514) 747-3380

Email:
info@speedware.com

Speedware 
Tech-Centre 
business hours:

As always — 9 to 5 your time
1-800-361-6782 (US or 
Canada)
(514) 747-9494 (Intl)
0.800.96.77.14 (UK)
(514) 747-3320 (Fax)

Email:
support@speedware.com

Support Website:
www.speedware.com/sws

Speedware, Visual 
Speedware, Speedware 
Autobahn, MobileDev, 
EasyReporter, Media and 
Esperant are trademarks of 
Speedware Corporation Inc. All 
other products are trademarks 
of their respective 
manufacturers.

© 2002 Speedware Ltd.
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Speedware Signs Partnership 

Agreements to Continue to Provide 

Customers with Affordable HP 

Equipment

As part of its commitment to protecting the 
value of the HP community's IT investments, 
Speedware has partnered with three HP 
equipment vendors. 

For the Canadian market, Speedware has 
signed an exclusive partnership agreement with 
Commerx Computer Systems, a value-added 
reseller of Hewlett-Packard computing 
platforms in Canada. Speedware and Commerx 
are both long-time partners of Hewlett-Packard. 
As such, they possess a unique appreciation of 
the needs of Canadian companies whose 
applications run on HP servers. Under the 
terms of the agreement, Commerx will become 
the exclusive provider of new HP hardware for 
Speedware's Canadian customer base. 

Furthermore, Speedware reached an 
agreement with Eurodata. The company will 
provide Speedware's customers with 
competitively priced refurbished HP equipment. 
It too has been offering HP equipment 
worldwide for two decades and has become 
one of the most reputable reseller of pre-owned 
HP equipment in the world. 

Finally, our customers from the US will benefit 
from Dimension Data's expertise as a provider 
of HP hardware. Through this partnership, 
Speedware customers will benefit from 
Dimension Data's skilled expertise in the 
assessment and recommendation of hardware 
environments.

HP reports success of its migration 

programs — Speedware's role 

instrumental

In mid-June, Hewlett-Packard announced that a 
wide range of customers and independent 
software vendors have already embraced HP's 
e3000 server migration initiatives. HP is offering 
these businesses a comprehensive array of 
migration services and incentives to ease their 
transition to other HP platforms. 

HP was proud to cite five strong examples of 
companies that have already successfully 
undertaken migration projects — four of which 
are using migration solutions by Speedware! 
CT3, Multomah Education Service District, 
Tenex, and Virginia International Terminals, Inc. 
are great examples of companies that are 
taking full advantage of Speedware's migration 
services.

Speedware's reporting and 

analytics tools integrated into 

Purkinje's solution to form 

complete e-patient care system

Speedware has announced that it has signed a 
distribution agreement with Purkinje. 
Speedware's advanced analytical and reporting 
tools will be integrated into Purkinje's 
application to offer a complete patient e-file 
solution to the health care industry. 

Purkinje will also act as a value-added reseller 
of Speedware's business intelligence tools to its 
customer base. The partnership will allow 
Purkinje's customers to generate powerful 
queries and reports from patient information 
contained in their Clinical Communicator 
application. Health and social service 
professionals will now be able to analyze and 
report on data from various existing sources 
such as patient files, diagnostics, laboratory 
test results, medical imagery, appointment 
management, and treatment planning.
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Where we've been
These are some of the conferences and conventions that Speedware has participated in lately: 

• June 19-20 — DCI's CRM Conference & 
Expo, Boston, MA. Speedware was pleased to 
meet with some of our customers in the Boston 
area at our exhibit booth and honored to 
participate in the discussion panel on Business 
Intelligence for CRM. 

• June 12 — Improving Business 
Performance with Analytics, Web Seminar. 
Speedware introduced our current users as 
well as newcomers to the power of OLAP 
technology through this educational online 
session.

• May 28-29 — Compu-finder Group 
Convention in IT (Congrès Technologique), 
Tremblant, QC.
Speedware met with local Quebec enterprises 
looking for a variety of IT solutions. This special 
event hosted seminars from some of the top 
professors in the IT field as well as an exhibit 
hall filled with Quebec's top IT solution 
providers

• May 15 — Creating Reports on the Fly, Web 
Seminar. 
Speedware educated our current users as well 
as newcomers on the speed and functionality of 
enterprise query and reporting through this 
educational online session.

• May 9-10 — Congrès des archivistes 
médicales, Lac Delage, QC (AQAM - 
Association québecoise des archivistes 
médicales). 
Speedware received a warm welcome from the 
members of the Quebec Medical Archivists 
Association at this special conference that 
highlighted the latest in IT for the healthcare 
field.

• May 6-7 — Journées Francophones 
d'Informatique Médicale , Quebec City, QC. 
(SoQuibs - Société Québécoise d'Infor-
matique Biomédicale et de la Santé). 
Speedware along with our Healthcare partner 
Purkinje, presented our robust BI solutions to 
members of the Quebec Society of Biomedical 
Information Technology at this unique 
international gathering.

• April 10-1 — Healthcare Informatics e.MD 
Conference & Expo, Rosemont , IL. 
Speedware demonstrated some of our BI 
solutions for healthcare to medical 
professionals at his unique event that 
showcased information technology solutions for 
medical practices.

If you missed one of our Web seminars on 
Reporting or Analytics and you would like to 
take advantage of this free education, you can 
now schedule a personal online seminar on one 
of these popular topics at the following Website:

http://www.speedware.com/whats_new/
upcoming_events/one_on_one_educational_ 
web_seminars/
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Web seminars
Since HP's announcement to discontinue the 
HP e3000 product, Speedware's DT Marketing 
department has been hosting a series of Web 
seminars for its client base and has had a very 
successful attendance rate. We hope that you 
have been able to attend our first Web seminar: 
HP e3000 Speedware applications: Choosing 
the right future path. 

During the month of July, August and 
September, we have scheduled the following 
events to better suit your schedule. Mark your 
calendars! 

• Planning and Budgeting for Migration — 
July 24 and August 21, 2002. During this 
presentation, we will discuss a wide range of 
issues related to Image database migrations, 
from database selection, to costs, 
comparisons, Speedware database code 
portability, industry trends, effects on 
applications, and solutions for technical 
caveats like arrays and date items. We will also 
propose migration methodologies to migrate 
your Image databases, give you a glimpse of 
our upcoming Windows-based database 
migrator tool, and discuss the advantages of 
database migration tools.

• Database Migrations — July 31, August 28 
and September 11, 2002. This Web seminar 
can help you make clearer choices. Our team 
of professionals will provide you with the 
information you need to prepare, plan and 
budget your migration endeavour. This seminar 
will address concerns such as the planning and 
budgeting of migrating, hardware and database 
choices and costs, resource planning, 
application “facelift” costs, as well as compilers 
and migration tools.

If you would like to know more about these 
events please visit the following link: 
www.speedware.com/whats_new/
upcoming_events/migration_web_ seminars/

We look forward to your participation.

Speedware day 
in Denver 
and Mississauga
This year, as you may already know, 
Speedware has decided to take its user 
conferences on the road. The first two events 
were held in Denver, Colorado on May 23, 2002 
and in Mississauga, Ontario on June 27, 2002. 

Each event consisted of a full day of 
presentations and discussions regarding the 
challenges that HP e3000 users are currently 
facing and the choices available to them. 
Speedware and partners Hewlett-Packard, 
DISC, Quest and Dimension Data discussed 
customers’ concerns including the planning and 
budgeting of porting, application and database 
porting, the replacement of reporting and 
analysis tools, as well as improving the visual 
interface of legacy applications. Participants 
had the opportunity to discuss the unique 
challenges they are facing and benefit from 
hands-on demonstrations.

The customer turnout was successful and we 
plan to hold many more in the next couple of 
months. Keep an eye on our Web site for more 
information.

Sneak Peak: SpeedWeb
Interested in instantly Web-enabling your 
existing Speedware V7 applications?

Speedware is proud to introduce SpeedWeb, 
an upcoming new component of Speedware 
Autobahn II. This new turnkey feature will 
completely Web-enable your existing V7 
applications and requires no application code 
modification at all. This easy step will enhance 
the graphical interface of your app and can 
significantly extend its life. To learn more, drop 
by our booth at HP World or visit us on the Web 
at www.speedware.com/speedweb

http://www.speedware.com/whats_new/upcoming_events/migration_web_seminars
www.speedware.com/speedweb
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Speedware at HP World 
September 23-27, 2002 - Los Angeles, CA

Drop by booth # 806 to learn about the new 
features of our application development 
technology and business intelligence products. 
You will also get a sneak preview of some of our 
new product features, such as Speedware 
Autobahn II's new feature known as 
SpeedWeb. Our team of HP e3000 migration 
experts will be hosting a number of training 
sessions and personalized demos about all 
aspects of migration planning. Catch one of the 
sessions hosted by us (see right for details) and 
join us at the “Migrate” Special Interest Group 
(SIG) on Wednesday from 3 to 5pm or 
participate in the SIG we will be hosting on 
Speedware solutions on Friday from 9 to 10am.

Look for Speedware in booth number 806. 

Speedware will host the following sessions:

Live Migration Demonstration: 

TurboIMAGE to RDBMS

Nick Fortin, Product Marketing Manager
Speedware Corporation
nfortin@speedware.com
Conference Track: MPE
Target Audience: Developers and Management
Technical Level: Intermediate
Summary — During this live demo, we will 
discuss a wide range of issues related to Image 
database migrations including database selection 
and costs, comparisons, Speedware database 
code portability, industry trends, effects on 
applications, as well as solutions to technical 
caveats, such as arrays and date items. We will 
also propose migration methodologies to migrate 
your Image databases, give you a glimpse of our 
upcoming Windows-based database migrator tool, 
and discuss the advantages of database migration 
tools. 

Migrating 4GL Applications Written 

in Speedware, Powerhouse & More

Christopher Koppe, Director of Marketing,
Speedware Corporation
ckoppe@speedware.com
Conference Track: MPE
Target Audience: Developers and Management
Technical Level: Intermediate/Novice

Summary — With the demise of HP e3000, 
many companies are evaluating what to do with 
homegrown 4GL applications. This session 
looks at the various migration paths available 
for Speedware, Powerhouse, and Transact 4GL 
applications. 

Budget, Timeline and Decision 

Inflexion Points for HP e3000 

Migrations

Christopher Koppe, Director of Marketing,
Speedware Corporation
ckoppe@speedware.com
Conference Track: MPE
Target Audience: Management
Technical Level: Intermediate/Novice

Summary — Planning and budgeting an 
HPe3000 migration can involve complex issues 
such as hardware and database purchases, 
3GL and 4GL data migration resources, and 
software licensing. This presentation offers 
various budget models and ways to plan an 
expenditure timeline for migration activities. 

806
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OdySoft
In December 2001, Speedware signed a 
strategic partnership with OdySoft to integrate 
Speedware's reporting and analytic software 
into OdySoft's workforce management (WFM) 
system (Calabrio). Speedware's business 
intelligence reporting and analytics suite 
provides OdySoft's system with high quality 
reporting and graphical analytics tools for 
enhanced decision-making and improved 
workforce management.

To accurately forecast and schedule contact 
center agents respecting budget constraints, 
contact volumes, service level, agents' 
preferences/skills, business rules, labor 
agreements, and other numerous variables, is 
a daunting and complex task. In the last few 
years, multi-site operations, multi-channels 
communication, customer and product 
proliferation have dramatically increased this 
complexity. In today's customer-centric 
business world, workforce management has a 
concrete and measurable impact on business 
operations, competitiveness and market 
positioning. Workforce management also 
strongly affects long-term planning and 
budgeting, agents' skills development, hiring 
and facilities operations. It has become a 
necessity for organizations to use a sound 
product suite that will answer their strategic 
challenges.

With Calabrio, it becomes simple to schedule 
the appropriate resources at the right time in 
sufficient number, at the best possible cost 
while ensuring that customer service levels are 
met and exceeded. It is also easy to plan 
accurate call distribution forecasts and agents 
schedules that match skill sets to business 
needs. The multilingual capability of the 
software (English, French, Spanish and 

Portuguese), quality, innovative “look and feel,” 
and user-friendly interface enable you to 
effortlessly optimize your resources while 
effortlessly allowing for both agent preferences 
and contact center objectives. This proven 
solution in 20 to 10,000+ agents centers, takes 
a few days to be trained on, is IT-friendly and 
has lean hardware requirements.

The Calabrio WEB II module offers real-time 
adherence management, supervisory 
functions, performance metrics tracking, and 
agent's self-service features. Outsourcing 
service is also available. Supervisor, Quality 
and Productivity, Workspace Management and 
Campaign are other value-added modules that 
provide you with the edge to reach your goal. 
Extensive functionalities, intuitive navigation, 
seamless third-party integration and quick ROI 
are just a few reasons that make Calabrio the 
most cost-effective and highly functional 
workforce management tool in the industry.

“We selected Speedware because of their 
complete range of business intelligence 
products and high quality client services,” said 
Gilles Plourde, Vice President Business 
Development, OdySoft. 

“We want to offer our customers the most 
comprehensive workforce management 
solution by adding the analytical and decisional 
component required to analyze and report on 
workforce activity within the call center market.”

Canadian and French Market Leader, OdySoft, 
offers “hot” solutions for tomorrow's workforce 
management, on three continents. For more 
info, visit us today at http://www.calabrio.com/ 
or contact us toll free at 1-877-646-4774 x223.
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University of Texas 

Business Intelligence

for a great cause

Researchers at the University of Texas at 
Arlington are using Speedware's OLAP tools for 
a great cause. 

Professors Dick Schoech and Joan Rycraft 
were recently awarded a DHHS ACYF grant to 
use OLAP technology to help the Texas 
Department of Protective & Regulatory 
Services (TDPRS) improve decision-making by 
working with large datasets, stored in TDPRS's 
data warehouse. The project team, assisted by 
Dr. John Fluke of Walter R McDonald & 
Associates, is using OLAP tools in the data 
gathering stage of what is known as an 
Evidence-Based Approach to Practice (EBP). 

The EBP approach will help TDPRS's decisions 
comply with Federal data indicators 
promulgated in the Adoption and Safe Families 
Act. Indicators such as the incidence of child 
abuse, the length of time to achieve adoption, 
and the stability of foster care placement have 
been defined and are part of the Act, which 
aims to promote the safety of children. Social 
services professionals, who practice EBP, 
search for the best evidence relating to each of 
the issues they are addressing and take 
appropriate action based on this data. 

Often, BI tools are used by knowledge workers 
in companies to help them improve the quality 
and speed of decision-making. It is interesting 
to see how field workers in the public service 
can also benefit from the strength of OLAP 
tools to promote social welfare.

Speedware 
and the HP-UX 10.20
As you know, Hewlett-Packard stopped 
producing and selling the HP-UX 10.20 
operating system at the end of June 2002. 
The discontinuance letter on the HP Web 
site includes the following statement:

"The HP-UX 10.20 operating system, along 
with the associated products and manuals will 
be available for purchase until June 30, 2002, 
after which time these products will be removed 
from HP's price list and enter maintenance 
mode."

In accordance with HP's decision, Speedware 
will soon stop certifying its development 
technology and business intelligence software 
on the HP-UX 10.20 operating system. 
Specifically, development technology software 
after Speedware V7.07 will not be certified for 
HP-UX 10.20. Speedware customers who 
encounter problems with our technology on 
HP-UX 10.20 should consider upgrading to 
HP-UX 11 if a solution is available on that 
operating system. 

Speedware applications should keep working 
smoothly when you move to HP-UX 11, but if 
upgrading proves to be a daunting task 
because of forward incompatibilities, our award 
winning SCP-certified Tech-Centre is available 
to assist you. 

For more information, visit us at 
www.speedware.com, or contact us at 
support@speedware.com. 

Let us know how we can give you a hand.

www.speedware.com
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Sorting records in the Dynamic Page Wizard
Autobahn’s Dynamic Page Wizard creates a 
set of Web pages that let end users perform the 
whole range of database functions: viewing, 
creating, modifying and deleting records. 
As part of the Speedware code that it 
generates, the DPW uses subsections to 
implement these operations. 

Subsections provide a handy way of reusing 
Speedware code; they work like functions but 
also have access to the current parameters, 
variables and so on. However, subsections do 
not support the SORT verb — and you may 
sometimes want to sort your records, for 
example before displaying a list of records. 

If you find yourself in this situation, we have a 
solution that lets you add the SORT verb 
outside the subsection, while conserving the 
original data-access and error-reporting 
functionality. 

To put this plan into action, follow these steps in 
Autobahn Designer (note that nearly all the 
work takes place in the Code Editors):

1. Open the repository and application containing 
the original data-access page created with the 
DPW — we’ll call it DPWPage. 

2. Run the Page Wizard (the regular Page 
Wizard, not the DPW) to create a new Web 
Program named SortPage, then delete its 
Speedware code from the Code Editor. You’ll 
be replacing the code in the next steps.

3. Send your original page — DPWPage — to 
the Code Editor and locate the ListRecords 
subsection. It looks like the one at the left 
below; you’ll notice it extracts and displays 
records, but does not sort them.

4. Copy the FOR loop in the subsection, then 
paste it into SortPage’s empty Code Editor. 

5. Back in DPWPage, delete the FOR loop and 
replace it with a section call to SortPage:

REPORT-SortPage 
USING _RECORD_COUNT MODIFY;

The variable _RECORD_COUNT is passed 
with the MODIFY option to conserve the 
DPW’s functionality of displaying an error 
message if the record count returned is 0. 

SUBSECTION ListRecords:
_RECORD_COUNT = 0;
FOR FLAT.TABLE1 SELECTED("Table1") DO BEGIN

_RECORD_COUNT = _RECORD_COUNT + 1;
IF (_RECORD_COUNT = 1) THEN BEGIN

PRINTHTML "DPWPage.html", "Header";
PRINTHTML "DPWPage.html", "ListHeader";

END;
LOADVAR {ITEM1} = $TRIM($EDIT(ITEM1), RIGHT);
LOADVAR {ITEM2} = $TRIM($EDIT(ITEM2), RIGHT);
LOADVAR {ITEM3} = $TRIM($EDIT(ITEM3), RIGHT);
PRINTHTML "DPWPage.html","ListRow";

END;
IF (_RECORD_COUNT = 0) THEN BEGIN

LOADVAR {_ERROR_MSG} = "No records meet your search
criteria.\nPlease enter new search criteria.";
CALLSUB "Query";

END;
ELSE BEGIN

PRINTHTML "DPWPage.html", "ListFooter";
PRINTHTML "DPWPage.html", "Footer";

END;
ENDSUB;

Before — the original ListRecords subsection

This subsection displays a list of 

records on a Web page, but it 
doesn’t sort them.
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6. Return to SortPage and add the verbs and 
events shown in the example (see ) .

• The TAKE verb saves the specified items in 
a take file at each record in TABLE1.

• The SORT verb sorts the records in the take 
file, providing the sorting functionality that 
was not allowed in the subsection.

• The AT TOP, HEADING events suppress the 
default report page headings, which are not 
needed in Autobahn Web reports.

• The AT RECORD event executes the 
LOADVAR and PRINTHTML verbs for each 
record — which are now sorted in order. 

7. The last step is to create a parameter in 
SortPage called _RECORD_COUNT to 
receive the value passed by the section call. 
Click the Edit Parameters icon in the Code 
Editor to create a 4-byte integer parameter 
(Storage: INT, Subtype: NUMERIC, Length: 
10.0, Storage size: 4).

See  for the PARM statement generated 

for your parameter.

You’ve now added the sorting functionality as a 
separate section which is called from inside 
DPWPage’s subsection. To see the sorted list 
of items in action, compile and then run the 
application.
Andrew Bocchicchio
Product Support Specialist

6

7

REPORT-DPWPage:
...
SUBSECTION ListRecords:
_RECORD_COUNT = 0;
REPORT-SortPage 

USING _RECORD_COUNT MODIFY;
IF (_RECORD_COUNT = 0) THEN BEGIN

LOADVAR {_ERROR_MSG} = "No records meet your
search criteria.\nPlease enter new search
criteria.";

CALLSUB "Query";
END;
ELSE BEGIN

PRINTHTML "DPWPage.html", "ListFooter";
PRINTHTML "DPWPage.html", "Footer";

END;
ENDSUB;
...
EXIT;

REPORT-SortPage:
PARM P-RECORD_COUNT FORMAT(INT,10,0,4);
FOR FLAT.TABLE1 SELECTED("Table1") DO 

TAKE ITEM1,ITEM2,ITEM3;
SORT ON ITEM1;
AT TOP,HEADING DO NOTHING;
AT RECORD DO BEGIN

_RECORD_COUNT = _RECORD_COUNT + 1;
IF (_RECORD_COUNT = 1) THEN BEGIN

PRINTHTML "DPWPage.html", "Header";
PRINTHTML "DPWPage.html", "ListHeader";

END;
LOADVAR {ITEM1} = $TRIM($EDIT(ITEM1),RIGHT);
LOADVAR {ITEM2} = $TRIM($EDIT(ITEM2),RIGHT);
LOADVAR {ITEM3} = $TRIM($EDIT(ITEM3),RIGHT);
PRINTHTML "DPWPage.html", "ListRow";

END;
EXIT;

After — a shorter subsection and a new section

6

7

The subsection now calls a REPORT 

section that sorts the list of records 
before displaying them. 

5

Not in subsections 

The following reporting verbs 

are not allowed in subsections 

coded in REPORT sections:

• AT

• BREAK 

• CONTINUE

• Any DCL or PARMs

• DELETE

• FNCKEY

• LINK

• SET

• SORT

• SUBSECTION (meaning 

subsections cannot be 

nested)

• TAKE
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Sysdoc: a developer’s dream
Sysdoc is a Speedware/Designer module that 
gives developers a quick and easy way of 
creating system documentation — detailed 
information about a design and the objects 
it contains.

From basic lists to complicated FOR loops, 
IF statements and variables, Sysdoc provides 
the information you need to manage your 
Speedware applications.

An easy Sysdoc example

Example 1 shows a Sysdoc document that lists 
the programs that access the CUSTOMER file. 
The output includes free text (“Programs using 
CUSTOMER”) plus the list of programs. Follow 
these steps to recreate the example: 

1. Run Designer and open a design.

2. Type DD+ to create a new document.

3. Enter a Reference, Name and Description.

4. Enter Type: Sysdoc (or press F6 Help).

5. Press F7 Accept to display the text window.

6. Enter the Sysdoc code as shown in the 
example, then press F7 Accept. Note:

• Substitute your own application name and 
file name.

• Don’t forget to put the # sign in the first 
column where shown.

• Text inside #NOTE – #ENDNOTE will not 
appear in the output.

7. To see the report, type DP (Document Print), 
then press F1 List on Window and F7 Accept. 
The document will be listed on screen.

Variables in Sysdoc

Example 2 shows the use of variables in 
Sysdoc documents. This example extracts 
information about the developers who created 
and modified Screen programs. 

Want more info? 

These examples are just the tip of the Sysdoc 
iceberg. For any kind of system documentation 
for your Speedware applications, Sysdoc can 
help you. For details, see the Sysdoc Guide in 
the Speedware online documentation set.

Robert Richardson
Consultant

#NOTE                                      
Find Screen programs in the current application using 
variables and report who created & modified them & when. 
#ENDNOTE
# FOR APPLICATION
# LET LVAPP = "!REF" 
# FOR PROGRAM IN APPLICATION<!LVAPP>† 
#  IF "!TYPE" = "SCREEN" 
Program Name : !REF
Format Type     : !FORMATTYPE
Database Name : !BASE 
File Name : !FILEVIEW 
Developed by    : !CREATOR on !CRTIME 
Last modified by : !MODIFIER on !MODTIME 
#  ENDIF 
# ENDFOR 
# ENDFOR

Example 1

#NOTE                                      
Find all programs in the MYAPP 
application that access the CUSTOMER 
file.  
#ENDNOTE                                    

Programs using CUSTOMER: 
# FOR PROGRAM IN APPLICATION<MYAPP>†

#  IF "!FILEVIEW" = "CUSTOMER" 
!NAME_________________
#  ENDIF 
# ENDFOR 

Programs using CUSTOMER:
CUSTOMER-MAINT
CUSTOMER-DETAIL
CUSTOMER-ORDERS

Example 2

Program Name  : QRYTEST
Format Type   : WINDOW
Database Name : IMAGING
File Name : IMAGER
Developed by  : MGR on 20-Dec-2001 09:21:07
Last modified by: ROBR on 22-Mar-2002 15:31:33

Output

Output

† For the examples to work, programs must be listed 
explicitly in the Application Definition (AD) screen. 
Simply having *All will not retrieve any programs.

Why Sysdoc?

Sysdoc helps you develop, 

test and debug applications 

by making it easy to:

• Obtain a comprehensive 

representation of the 

objects in a design.

• Record the application’s 

progress to date using 

creation and modification 

dates. 

• Produce documentation to 

any level of detail and 

refinement.

• Enhance information with 

free text and formatting 

and other Designer 

documents.

• Send output to a window, 

terminal, file or printer.
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Expanding List Selected in Visual Speedware
Visual Speedware applications usually include 
a List Selected window — a list of records 
selected for processing in the form.

The size of this window is limited by the form, 
meaning that the window is sometimes too 
small to display its contents comfortably. But if 
you enlarge the form to accommodate a large 
List Selected window, you can end up with an 
overly large — and half empty — form. 

An easy way to resolve this dilemma is to use 
form events to manipulate the form size and 
position at run time. Follow these steps: 

1. Create your form in Visual Speedware using 
the Form Wizard; make it any size you like. 
Keep the default List Selected position — 
List Selected in Form — but see the next 
page  to display the List Selected in a frame. 

2. Use the Repository Browser to create four 
local variables in the form. These variables will 
hold the original dimensions of the form. Name 
them L-FORM-WIDTH, etc. and define them 
as 4-byte integers: Storage: INT, Subtype: 
NUMERIC, Size: 10.0, Storage size: 4
(see  below for the code generated). 

3. Calculate the size and position needed to 
display the List Selected window properly, for 
example, 8000 x 4000 twips. (Estimate these 
numbers by looking at the dimensions of the 
form in the Properties window.)

4. Use the form’s Code Editor to resize the form 
when List Selected opens in the ENTER-LIST-
SELECTED event. Here’s how:

In Enter-List-Selected, enter code (see  
below) to save the form's current size and 
position in the four variables, then resize the 
form with the optimal List Selected dimensions 
you chose in step 3. 

5. Still in the Code Editor, restore the original 
dimensions of the form in the events that can 
occur when List Selected closes, CHOOSE-
RECORD and EXIT-LIST-SELECTED:

Enter the resizing code (see  below) in 
Choose-Record, then copy and paste the 
same code in Exit-List-Selected — or use a 
subsection as described on the next page. 

Now the form’s List Selected window will 
automatically resize and reposition itself when 
it opens and the form will return to its original 
size and position after List Selected is closed. 

FORM-frmCUSTOMER:

(* Declare four 4-byte integer variables *)
DCL L-FORM-WIDTH FORMAT(INT,10,0,4);
DCL L-FORM-HEIGHT FORMAT(INT,10,0,4);
DCL L-FORM-TOP FORMAT(INT,10,0,4);
DCL L-FORM-LEFT FORMAT(INT,10,0,4);

(* When LS opens, save original form size *)
AT ENTER-LIST-SELECTED DO BEGIN

L-FORM-WIDTH = frmCUSTOMER.Width;
L-FORM-HEIGHT = frmCUSTOMER.Height;
L-FORM-TOP = frmCUSTOMER.Top;
L-FORM-LEFT = frmCUSTOMER.Left;

(* Then resize and position for LS *)
frmCUSTOMER.Width = 8000;
frmCUSTOMER.Height = 4000;
frmCUSTOMER.Top = 200;
frmCUSTOMER.Left = 200;

END;

(* When LS closes, restore original form size *)

AT CHOOSE-RECORD DO BEGIN
frmCUSTOMER.Width = L-FORM-WIDTH;
frmCUSTOMER.Height = L-FORM-HEIGHT;
frmCUSTOMER.Top = L-FORM-TOP;
frmCUSTOMER.Left = L-FORM-LEFT;

END;

AT EXIT-LIST-SELECTED DO BEGIN
frmCUSTOMER.Width = L-FORM-WIDTH;
frmCUSTOMER.Height = L-FORM-HEIGHT;
frmCUSTOMER.Top = L-FORM-TOP;
frmCUSTOMER.Left = L-FORM-LEFT;

END;

5

2

4

Bold indicates the code that you 

enter in the Visual Speedware 

Code Editors. 

2

4

5

At run time, 

during List Selected
...is enlarged 

a small form

... and returns to
its original dimensions
when List Selected closes.
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Subsections

When you have identical code to execute in 
more than one place, you should think about 
using a subsection. Subsections provide a 
handy way of duplicating code, and they have 
access to the section’s parameters, variables 
and tables.

To use a subsection in this List Selected 
example, replace step 5 (in which you enter the 
form-size-restoring code in two events) with the 
following steps:

5. Use the Repository Browser to create a 
subsection under the form; call it 
RESET-FORM. 

6. Open the subsections’s Code Editor (right-
click and choose Edit Code) and add the 
form-resetting code (see  below). 

7. In the form’s Code Editor, call the subsection 
with the CALLSUB verb in both the Choose-
Record and Exit-List-Selected events 
(see  below).

See below for the specfile code that Visual 
Speedware generates for the subsection and 
the subsection call. 

This is just a small example of using sub-
sections; you’ll appreciate their advantages 
even more in a large application. See “Sorting 
records in the Dynamic Page Wizard” on page 
9 for a discussion of subsections in a 
Speedware Autobahn II application. 

List Selected in frame

The List Selected window can either occupy 
the entire form or it can be displayed in a frame. 
Framing it is useful when a form has subforms 
or controls that need to be visible while in List 
Selected. 

Even if you are resizing a small form to 
accommodate the List Selected, you might 
still want to display it in a frame. For example, 
you might want to increase just the width of the 
List Selected but still leave some buttons visible 
at the bottom of the form. To use a frame:

1. Set up the form-resizing code described in 
steps 1 through 5 on the previous page.

2. Use the Visual Basic tools to draw a frame 
on the form, positioning it on top of the form. 

3. In the Properties window, size the frame based 
on your optimal List Selected dimensions. The 
frame will exceed the dimensions of the form, 
but that’s fine — the form will be resized at run 
time.

4. Select the frame, right-click and choose Apply 
Function to Control; select List Selected Place 
Holder (with or without buttons). 

5. Right-click the frame and Send to Back. 

When List Selected is displayed, it will appear 
in the frame within the resized form. 

Marc Cordeau
 Product Support Specialist

6

7

6

7

(* This code calls a subsection from both events *)
SUBSECTION RESET-FORM:

frmCUSTOMER.Width = L-FORM-WIDTH;
frmCUSTOMER.Height = L-FORM-HEIGHT;
frmCUSTOMER.Top = L-FORM-TOP;
frmCUSTOMER.Left = L-FORM-LEFT;

ENDSUB;

AT CHOOSE-RECORD DO BEGIN
CALLSUB "RESET-FORM";

END;

AT EXIT-LIST-SELECTED DO BEGIN
CALLSUB "RESET-FORM";

END;

Coding and calling 

a subsection
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Media applications with multiple data sources
Do you have multiple data sources? Have you 
created multiple dictionaries? Are you using 
Decision Server and Media’s multi-dictionary 
function to tie them all together? If not, you’re 
really missing out. Read on!

Media V4.0 includes a feature that lets you 
map objects from one dictionary to another. 
This multi-dictionary feature helps you re-use 
existing Media dictionary objects (indicators, 
dimensions, calculations, etc.), in new or even 
existing dictionaries. 

So what’s the benefit? First, consolidation. You 
can choose the most useful bits and pieces of 
existing dictionaries to create one application 
that meets the needs of most users. Second, 
multi-source access. With the multi-dictionary 
feature, users can analyze data from multiple 
sources in just one briefing board.

Remember, you need Decision Server for this 
job. If you don’t have it, just contact your 
Speedware rep.

Let’s give it a try

Here’s how you create a multi-dictionary 
environment from scratch:

1. Create System DNS ODBC connections for 
all your data sources. User DNS will not 
work.

2. In the Esperant Administration System, 
create a new repository. Then create a data 
view for each dictionary you will use in your 
multi-dictionary environment.

3. Now create the dictionaries: For each data 
view, choose View > OLAP View in the 
Administration System to open EditDict and 
create the dictionary. These dictionaries will 
be secondary dictionaries. The main 
dictionary you’ll create in step 5 will map to 
indicators and dimensions in your secondary 
dictionaries.

4. Open the Decision Server and create a 
Decision Server service for the repository you 
created in step 2. Start the Decision Server 
service.

5. Create a new dictionary in EditDict. This will 
be the main dictionary for the application. It 
will use indicators and dimensions from your 
secondary dictionaries.

6. In your main dictionary, choose Dictionary > 
Multi-Dictionary. The Multi-Dictionary Editor 
is displayed.

7. Click New. The Multi-Dictionary Options 
dialog is displayed. This dialog lets you 
specify which secondary dictionary you want 
to map to. Do the following:

• Change the Type to Media.

• Enter a name to identify the secondary 
dictionary.

• Enter the Decision Server IP address.

• Enter the port number for the Decision 
Server service you created.

• Enter the user name and password for the 
repository that contains the secondary 
dictionary.

• Specify the relative path from the Esperant 
data view folder to the secondary 
dictionary. For example: 
\Esperant_data_view_folder\DICT.DIC.

8. Click OK and then Close in the Multi-
Dictionary Editor. The secondary dictionary’s 
indicators, calculation rules and dimensions 
are displayed in the main dictionary.

9. Repeat steps 6 to 8 for every secondary 
dictionary you want to map to. 

After you save the main dictionary, use it to 
create a briefing board that incorporates 
objects from the secondary dictionaries.

Anthony Novello 
Operations Manager

Multi-dictionary Q & A

Q: How do I know which dictionary 
objects are from the secondary 
dictionary?

A: They’re displayed in blue, and 
the dictionary name becomes 
part of the object name:

Q: Do I have to start from scratch?
A: Of course not. You can easily 

create a multi-dictionary 
environment from an existing 
dictionary. All you need is a 
connection to secondary 
dictionaries via Decision Server. 

Q: Can I create a multi-dictionary 
environment with matrix 
dictionaries?

A: Sure. Whether you use matrix or 
relational dictionaries, the 
procedure is the same.

Q: How do I refresh dictionary 
objects?

A: Open the Multi-Dictionary Editor 
and click the secondary 
dictionary whose objects you 
want to refresh. Then click 
Refresh.

Q: If I create a multi-dictionary 
environment with matrix 
dictionaries, where do I load the 
*.DAT files?

A: Remember, the multi-dictionary 
feature “links” to source 
dictionaries, so all loading must 
be performed on those 
dictionaries.

Q: Can I modify secondary 
dictionary objects from within 
the main dictionary— that is, 
rename them, edit their space or 
delete them?

A: Not yet. However, future 
releases of Media will have this 
functionality.
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Fonts and colors 
add pizazz

Liven up your Esperant reports
Reports have to display solid, useful 
information in a clear format, but that doesn’t 
mean they have to be visually dull. So here are 
a few guidelines for adding some pizazz to your 
Esperant reports. 

Before we get started, a helpful hint: whenever 
possible, save your customization settings as 
defaults—it’s easier to have font and color 
changes applied automatically than to do them 
manually time and time again. And a word of 
caution: try not to use too many different colors 
and font faces, or your report could look a little 
cluttered or busy. Sometimes less is more. That 
said, let’s get started:

Fonts!

The first way to add punch to an existing report 
is to change the overused MS Sans Serif font. 
You can use one font for all your headers and 
footers, and have another font for the page title 
and details. Once you’ve chosen fonts for an 
existing report, make sure to specify the same 
settings for future reports. You can do this 
under Tools > Options > Default Fonts.

Color!

Esperant is a versatile reporting tool. Take 
advantage of it by adding color where you want 
(without being forced to add color where you 
don't!). Color can help focus attention on key 
areas of the report. From backgrounds to fonts, 
keep in mind that sharp-looking reports usually 

use shades and tones of just one or two colors. 
For example, you can add a navy blue 
background to the page header, have a slightly 
lighter blue as the background of the column 
headers, and then lighter shades of blue for 
group header fonts and backgrounds. 

As a final touch, use the lightest blue (perhaps 
from the group header background) as the font 
color of the page header title. A little contrast 
can do wonders for your report. Try changing 
your title font color to white on a dark 
background.

Graphs!

Good reports should create a complete picture 
of a given situation, so why not throw in a graph 
or two? Use the Insert menu to add a crosstab 
graph. Crosstabs depict your data from a higher 
level and with a different display. They help 
managers view the same data from a different 
perspective.

Graphs summarize report data
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Calculations highlight 
important information

Last but not least, calculations!

Calculations can be really helpful in analyzing your data. Why 
not create a column that will contain color-coded alert 
information? 

This addition will enable managers and executives to pinpoint 
problem areas at a glance. 

For your report to look like this Call Activity Report, your 
calculation column (the last column shown in the report) must 
contain the following syntax:

If ([Talk Time] > 60)
Then COLOR = RED
RET="Warning !!!"

Else If ([Talk Time] < 10)
Then COLOR = GREEN
RET = "Great!"

Else RET = ""
EndIf

That’s enough to get you going for now. Here’s hoping these tips 
help you spice up your reports.

Karine Alves
Consultant
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RPC and the HP e3000
Current versions of Visual Speedware and Speedware Autobahn II use sockets-based technology 
to handle the distributed access required by these client-server products. Earlier versions used 
DCE-RPC (the Remote Procedure Call service of Distributed Computing Environment). If you are 
using one of these versions on the MPE platform, you may require operating-system patches in 
order to run your applications, depending on your version of MPE and RPC. The Speedware product 
versions that use DCE-RPC are:

• Visual Speedware V1.02 and V2.00

• Speedware Autobahn V1.4 and Speedware Autobahn II V2.0

Patches

The following table summarises the patches required to run Speedware products that use DCE-RPC 
on HP e3000 platforms:

MPE version RPC version and patches Compatible?

5.0 1.0.x Yes

6.0 1.0.x + ITOED07A + MPEKXP3A Yes

1.2.1 is not compatible
Uninstall patches to return to RPC 1.0.x. Contact HP for details.

No

1.0.x + Power Patch 2 Yes

6.5 1.0.2 + Power Patch 3 + ITOED07B
Additional patches (MPELXU5, ~W8, ~X3, ~K5, ~P2, ~N4 or 
~L2) may cause problems. If so, upgrade to RPC 1.2.1.

Yes

1.2.1 (via FRIMX47C) + ITOED07B
FRIMX47C fixes the unresolved externals problem.

Yes

7.0 1.2.1 via Power Patch 1 + FRIMX47B + MPEKXE4D + 
ITOED07C

Yes


